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0.2 Document History

Only integer versions are authorised for development.

Version No. Summary of Changes and Reason for Issue Associated Change
CWO, CP, CCN or
PEAK Reference

0.1 03/10/2022 Initial draft versions not released for review N/A

0.2 06/10/2022 New draft version with amendments following the document N/A

being used in a training session.

0.3 07/10/2022 Typo corrections. N/A

0.4 20/10/2022 Further amendments identified during KT session N/A

0.5 09/11/2022 New Section 2.8 Creating the POL All Live Defects Report has | N/A

been added that details the instructions for creating the POL
All Live Defects Report

No other changes have been made to this document other
than what has been detailed above.

0.6 11/11/2022 Added an instruction for new potential or confirmed Defects to N/A
add the “Date first logged at HDR (dd/mm/yyyy)” as the date of
the HDR Meeting that this will be presented to POL for the first
time.

No other changes have been made to this document other
than what has been detailed above

0.7 07/12/2022 Amended section 2.8 Creating the All Live Defects Report to N/A
include reporting against the new Response Category
“Accepted Live Defects”.

No other changes have been made to this document other
than what has been detailed above.

0.8 09/12/2022 Amended section 2.8 Creating the All Live Defects Report to N/A
include reporting against the new Response Category
“Accepted Live Defects”.

No other changes have been made to this document other
than what has been detailed above.

0.9 20/01/2023 Amended section 2.8 Creating the All Live Defects Report to N/A
include column names and removed Paul Smith from the POL
DL for sending the report to POL.

0.10 16/03/2023 Accepted changes from version 0.9. N/A

Amended section 2.5 Sending POL the Weekly HDR Report to
reflect that this report is sent to Michelle Stevens at the Post
Office and not Lisa Millar.

Amended section 2.8 Creating the POL All Live Defects Report
to reflect that this report is sent to Michelle Stevens at the Post
Office and not Lisa Millar.

No other changes have been made to this document other
than what has been detailed above.

1.0 17/03/2023 Approved version N/A

1.1 02/08/2023 Amended the Section 2.8 Creating the POL All Live Defects N/A
Report to include the Microsoft Information Protection steps
that need to be followed in order to produce the report.

No other changes have been made to this document other
than what has been detailed above.

2.0 03/08/2023 Approved Version N/A

2.1 26/04/2024 Creating a new Section 2.9 Saving the emails for the All Live N/A
Defects Reports for POL to SharePoint to include instructions
on saving to the required Sharepoint location.
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Version No. Date Summary of Changes and Reason for Issue Associated Change
CWO, CP, CCN or

PEAK Reference

No other changes have been made to this document other
than what has been detailed above.
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0.3 Review Details

Review Comments by: (date by which comments should be returned)

Review Comments to: (author’'s email) + POA Document Management

Mandatory Review

Role Name

Optional Review

Role Name

( *) = Reviewers that returned comments

Issued for Information — Please restrict this

distribution list to a minimum

Position/Role Name

0.4 Associated Documents (Internal & External)

References should normally refer to the latest approved version in Dimensions; only refer to a
specific version if necessary.

Reference Version Date Title Source

PGM/DCM/TEM/0001 | See note | See note above POA Generic Document Template Dimensions

(DO NOT REMOVE) | above

PGM/DCM/ION/0001 POA Document Reviewers/Approvers | Dimensions

(DO NOT REMOVE) Role Matrix

Alphabetical order

please

SVM/SDM/PRO/4317 | Latest See Dimensions POL Horizon Defects Review Terms Dimensions
of Reference

SVM/SDM/PRO/0875 | Latest See Dimensions Application support Strategy Dimensions

CS/MAN/011

0.5 Abbreviations

Abbreviation Definition

Alphabetical order please
HDR Horizon Defect Review
HDR-FIN Horizon Defect Review — Financial Impact
HDR-EXP Horizon Defect Review — SPM Experience
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SPM Sub Post Master

PBS Payment and Banking Service
PROD OUT Production Out Date

SME’s System Matter Experts

HTML Hyper Text Markup Language
PNG Portable Network Graphics

JPEG Joint Photographic Experts Group
CBIF Customer Business Impact Forum
POL Post Office LTD

MGT Management

TfSNow TRIOLE for ServiceNow

PEAK Peak Incident Management System

0.6 Glossary

Term Definition

Alphabetical order please

0.7 Changes Expected

_

0.8 Accuracy

Fujitsu Services endeavours to ensure that the information contained in this document is correct but, while every
effort is made to ensure the accuracy of such information, it accepts no liability for any loss (however caused)
sustained as a result of any error or omission in the same.

0.9 Information Classification

The author has assessed the information in this document for risk of disclosure and has assigned an information
classification of FUJITSU RESTRICTED.
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1 Introduction

This document describes the way in which the various internal and external Defect Management reports
are produced for LIVE Defects including branch impacting. It can be used as a procedural document that
can be referred to and updated in line with changes and/or improvements that are made to the Defect
Management reports as they evolve and change owing customer or internal requirements.

1.1 Overview of the Live Defect Management Reporting
approach

1.2 The Goal

e |f the Live Incident or Live Defect affects, or could affect, branch operations, we share it with POL
in a weekly HDR Report and at the Horizon Defect Review (HDR) weekly meeting

1.3 Background

e The Defect Management reports are produced for internal and external distribution in order to
demonstrate Fujitsu’s management and communication of the LIVE affecting defects including
those that have a branch impact.

e The LIVE affecting defects reported to POL will have one or more of the following collections
added in order to qualify as a candidate for reporting:

o ##lLiveAffectingDefect
o HDR-FIN — Horizon Defect Review — Financial Impact
o HDR-EXP — Horizon Defect Review — SPM Experience
e These Defects could be in various stages whilst reporting on them to POL.:

o INVESTIGATING - A Live Defect will start out as a Potential Live Defect until sufficient
investigation has taken place

= [Fujitsu internal unless linked to a bonded Incident]

o SOLUTIONING - If a fault is confirmed then this will progress to be a Confirmed Live
Defect (if it is not a fault then the Potential Live Defect will be closed)

= [Fujitsu internal as a solution still needs to be identified and agreed]

o PROPOSED FOR - Once a solution is identified for a Confirmed Live Defect it will need
to go through the POA processes before the fix is assigned to a sensible Release

= [Fujitsu internal involving developer / feature conflict check. Counter defects are
discussed with POL]

o TARGETED AT - Releases are then managed through to deployment to Live

= [Visible to all parties as the Release work starts]
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2 Live Defect Management Reporting
2.1 Weekly HDR Report Creation Work Instructions

To create the weekly HDR Report, which is shared with POL, follow these steps:

o The criteria to be used to determine HDR reporting candidates to share with POL will be
determined by creating a list using the following logic. The resulting list allows for the HDR
candidates to be identified.

o Prepare the report to send to POL

e A spreadsheet format has been used to date so the previous week’s POL “HDR Defects
update report — dd.mm.ccyy v1.0.xIsx” submission should be used as the basis for the
new report — removing all previous week highlighting and deleting rows scored out as
POL have been told these are being removed.

= Save the file as v0.1 initially and use v1.0 for the version that is shared with POL.
As a visual reminder add WIP into cell B2 and lastly delete the “HDR Report”
Tab, which contains last weeks extracted data.

= |t may be easier to create several draft versions i.e. v0.1, v0.2, v0.3 etc during
the creation of the report, so that it is in a state suitable to create v1.0 to share
with POL.

=  Amend the date in F3 making sure to leave it as a text field or the title of the
section below it will not render correctly

o Create the Peak extract to build the report from

e Then, open any version of the “Peak_Defect Management extract dd.mm.ccyy
hh.mm.xlIsx” spreadsheet and Enable Content and go to the Data tab
“##l iveAffectingDefect” and click Refresh All. The password to run the embedded

...................... y

queries needs entering 3 times and is| IRrReLevanT. Save the resulting file with the

timestamp to match when the extract was created — so it can be referred back to. Turn
off AutoSave

o Quick filtering method:
e Go to the “HDR Report Pivot” tab

PROD OUT Planned Date [t

iResponse Categary ik
Status b i .
{HDE Classification f;m SHhEnio. it Lrlsots S Exp
Deferrad a3 opy
PEBS Project B Pormar Tells., .
"f\ AT
Count of Summary [B Refresh

&)
n

tove >

LA Remmye "HDR Classification”

el Field Sattings...

PivotTable Qpticns..,

Hide Field List

° Check that all thé filters are accufate and rhatch the description shown:
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REFRESH sitiveAtfectingDefect TAB THEN REFRESH THIS PIVOT AND CHECK THE FILTERS AS SHOWN

: PRODOUT Planped Date: (Muitiple ftemst ¥ Cnech PROD OUT Manrad Date ondy ticks the blarks and future dates
Bezponse Categary {piadsiple Homsp 8 X
Sratuz iMuftipde ftem

HOR Clegsification {siultiple teny
Deferred t&8H

DBS Projac (Al
E Boubde chick the number shown 0 2xpose the result set for reporting & rerame the @b to Deferred/PES/Othar
Count of Summary

53

e Ensure that you have set Deferred and PBS Project to (All)

e Pay special attention to the “PROD OUT Planned Date” which may have had new future
dates added that need to be ticked

Cali Type Defect identified XIS
SROD OUT Planned Date {Multiple ems} 415
Resp Jo R+
b s e
HORCH
Targe&f

BiF Dial
PTF Pig

act Multipie ez

ok | ranee

o List — Deferred, Project and HDR Live Defect Peaks

Response Category
Status

HDR Classification
Deferred

2RSS Project

e |f there are any Deferred, Project and HDR Peaks to consider, a number will appear
under the Count of Summary
Count of Summary

30

o Double click on the number to open a new sheet with the relevant Peak(s) listed
and rename it “HDR Report”.

o ltis more likely that the result set largely matches the previous results showing in
the HDR Report.

o Compare the previous HDR report to the new list and amend accordingly so the
new HDR report list matches what the system now shows

o Todo this it is worth hiding the following columns as it makes to easier to
compare the data against the previous HDR Report:
= C - Date Opened

= D - Product

= E - Product Group

= G - Priority

= H- Assignment Team
= |- Status

= J - Response Category
= K- Root Cause
= M - References
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= N - TfSNow Reference

= O -POL SNOW Reference
= P — Contact Name

= R - Business Impact

e ltis good idea to mark for each Defect PEAK the “Call Reference”, “Description”, “Target
Release Type” and “Target Release” red on the HDR Report tab of the
“Peak_Defect_Management extract dd.mm.ccyy hh.mm.xIsx” once checked against the
previous HDR Defects Update Report dd.mm.ccyy.xIsx.

e Also check column AH “Planned Out Date” to ensure that any dates previously reported
against in the HDR Defects Update Report under “Current Target Release Date” have
not been amended or if any new dates have been added for Defects that had previously
been blank.

e |f any dates have been amended or added, then please add to the Current Target
Release Date of the HRD Defects Update report and add a new HDR extract.

e Also check column AG Date Time Last Updated to see if any Defects have been updated
in the last week. If so, check the Defects to identify the changes and if the Impact Tab
has been updated then please add to the HDR Report. Other updates such as comments
added to the Detail Tab may not require to be communicated to the customer as this
could a JIRA reference or log needed to further investigations.

& PN Pad status S
E Defect ider HDR-Fin, $4iiv Yes During Existing Rev Repork
Defect idery HOR-Fin, #livYes if 3 counter perforr Targated 41
Defect ider HDR-Fin, #¥livYes After afailed stock Targeted 81
I Blafact ide; C3rd, #8ivi Yes Haclerkyzectha T lareated 41
ragr e Defect ident HDR-Fin, #livYes During this basket o osed For
: ! LiveAffectin o i Transactionlogs Targated At
x - Defect ideni ,SSC3rd, ##iiviYes h‘acier} gsesthe T2 o]
2 Defect iden HDA-Fin, #livYes Declined fransactic fopariod in
¢ Defect ider HDR-Fia, #ivYes This issue is the res Targated At
2} Dedect iden HDR-Fin, #liv Yes AP Transachion {SulTa
Defert iden #itvesffectin No if a PBS Balance End Proy ¢
crass Befect idery HOR-Fin, ##livYes inrare cases, preve Targated A1
zact Defect iden' HDR-Fin, .S53CFYes if the user presses Targetad &1
ter Bolect iderd SSCRandR, ## Mo On PBS counters wiTargaied &1
Business impact W Rgvie
inNo  Business impact if
tiveAffectinblo During Existing Rev!
eAfectinYes There have bea
£ ,ing RE'versaésiﬁr
270,40 € Defect icer Bi"ﬂzpprovec ':'xié
# to Detact iden Sattars, SSCCEMD
CRE-5606 - L Dafect iden $8ivedffactin in pamcﬁar%y Yare
R70.50: ATC Defect iden! BiFApproved, No For 8P-ADC trmsaﬂargez“d A*
7952% - Defoct idemi 58C - 4th Linse, Mo Sep Title, thisis he Br
CER-5258 - H Defert iden Bifdpproved, The history fext get
LET:REL_ND Defect ider BiFAgproved, Mo When the Clerk att #r “or
LST: R70.20 ( Dedect ideni BifApproved, Yes Duringa Rem in fo Brop ar 2 >
R0 I0-2VES Defect iden' BiFApproved, For sommie back offic Targeted At HNG-X 72,20

° Any that have been closed should be moved to the HDR Closed Defects section of the

HDR Report and highlight in yellow:
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e Any that are new should be added to the list and highlighted in red on the HDR Report
tab whilst they are checked and completed

@]

These then need scrutiny to ensure they look correctly tagged as HDR.
This will require the Peak to be read and checked

If they are HDR, then the Impact tab needs checking to ensure it is
complete and reads well. Any amendments should be referred to the
SMEs for updates to be added to Peak
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o Ensure that the Date first logged at HDR (dd/mm/yyyy) is completed with
the date of the next meeting (normally a Monday) for which this potential
or confirmed new Defect will be presented to POL in the HDR meeting.
Field from the Impact Tab illustrated below:

}Dzatc first logged at HDR {dd/munv'vyyy) 241192022

o When the report is ready to submit, the highlighting on the new rows
should be changed to yellow
o Extract the list showing:

HOR Defects

POL Reference (from column BI)
POL Title (from column BN or set to N/A for a new entry)
Category (from column BF)
Fujitsu Reference (the Peak Call Reference from column A)
Summary (the Peak Summary field from column B)
Confirmed Defect (set to “Yes” if Call Type in column F is “Defect
Identified” or “No” otherwise)
Workaround (from column Q)
Update (manually updated to pick out any changes made week to week
on the Peak in question — if nothing has changed (as is typical once a
Peak is Targeted At) then the “No change since dd/mm/ccyy” will
probably be ok to leave as is. If any updates are identified, set this cell to
YELLOW FILL
Target Release Type (from column S)
Target Release (from column T)
o HDR Extract
= Create the file to embed:
= This is created within Peak from the Impact tab
=  Open the Peak and go to the Impact tab

O 0O O 0 0 ©

o O

o O

o

= (Click on the Export icon on the top right

gmj%

= Aview of the Impact screen is presented in a new window
= Right mouse click and choose “Save as”

st e
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= Save the file
o Embed the file
= Click on the cell into which the saved HTML file is to be
added
= Click on the Insert menu option at the top

SN insert Page Laye

in the Text section

¢ Waopddat v

- goature Ling ~ |
Yot Heasder i
Bo & Faokas

Chject

= Click on the “Create from File” option on the screen that
appears

Ghject ? X

Lreate New  Create from File

Fite nacee:
: Browse..
T Linkto file
Tioispiay as icon
Rasult
Inserts the contente of the file into your
P " document o that you an edit i fater
B wsing the progeam which created the

source fite

i oo | Cancet

= Click on Browse and then navigate to and click on the
relevant file and select “Insert”

= Then click OK

= The file will be inserted into the cell in the HDR report
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Screenshots
= |f any screenshots have been requested or are needed, first
save the screenshot to a file (PNG or JPEG)
Embed the file

Click on the cell into which the saved HTML file is to be
added
Click on the Insert menu option at the top

e insart Pagye Laye

Click on Object in the Text section

4 as
i WordAad v

- gnatuee Line ~
Fexk Hesder o i
Box 4 Footer B Dhject

Tev i
Click on the “Create from File” option on the screen that
appears
Chject ? X

Create New  Lreate from File

Fite name:
i Brovwse.
[Link to file
[_J Eisplay a5 icon
Result

Inzerts the contents of the file into yaur
dewment so that you can edit it later
wsing the program which oreated the
source fife,

oy

o Canest

Click on Browse and then navigate to and click on the
relevant file and select “Insert”

Then click OK

The file will be inserted into the cell in the HDR report

If itis a PDF document, you will need to click on Display as
icon checkbox
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Craste from Fis

Sowsge.

FLONL L pf

SHemngn o

R 3 S

o Click OK and then resize the PDF document in the cell
o Once all details are added please ensure that all the row illustrating the
new Defect is highlighted in yellow.

FYI ONLY — MANUAL FILTERING
o If the HDR Report Pivot is absent or corrupted, then the manual filtering is as follows
o Go to the #ilLiveAffectingDefect tab and filter as follows:
e Set the filter on Response Category [column J] to exclude the No Fault Found values
(see Appendix A)
e Set a filter on HDR Classification [column BF] to exclude blanks
e Set afilter on Planned Out Live [column AH] so the dates are in the future or blank (it has
not been deployed)
e Exclude closed Peaks where Status [column 1] is “C” — as these may have been fixed
outside of a release by Ingenico themselves
o Then the 1 List needs to be created that can be used to compare against the previous week'’s
report:
o Deferred Live Defect Peaks
e Set the filter on Deferred [column BH] to “Yes”
e These are unlikely to be discussed at HDR as they are previously approved and
understood but are provided to show the level of Fujitsu control
o Project Live Defects
e Set the filter on PBS Project [column BG] to “Yes”
e These are unlikely to be discussed at HDR as they are part of the ongoing Project
Manager regular review calls
o Non-Project Live Defects (likely originating from an Incident during normal service delivery)
e Change the filter on PBS Project [column BG] to exclude “Yes”
e These require more comprehensive information as these will be discussed at the
HDR meeting
e Extract the list as described above
o These previously were listed as individually in their own sections but is now reported all together.
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A.1 2.2 Weekly CBIF Submission Extract Work Instructions

To identify if there are any CBIF submissions necessary to POL, follow these steps:

o Create the Peak extract to build the report from
e Open any recent version of the “Peak_Defect_Management extract dd.mm.ccyy
hh.mm.xlIsx” spreadsheet and Enable Content and go to the Data tab and click Refresh
All on each tab. The password to run the embedded queries needs entering 3 times and
isE'EEE[E'\;RF?, Save the resulting file with the timestamp to match when the extract was
créatéd =0 it can be referred back to. Turn off AutoSave
o Quick way

e Go to the “CBIF Peaks Pivot” tab

S

e Right mouse click on any part of the filter

cali Tyve Defart identified ¥
PROD OUT Plann
Response Categ
Status

HOR Classification
Target Ret TNy
B Manned Date !
PTF PManned Date
(BF Ticked Quest
Actioned Team

: Count :czrfsyun'u'nar\'é

& Field Settings..,

ParotTable Options.

Hide Feld List

e Check that all the filters are accurate and match the description shown:

; REFRESH #fitiveAfiectingDefect TAB THEN REFRESH THIS PIVOT AND CHECK THE FILTERS AS SHOWN
iCatf Type Brefect identified X Set o Defert identifiad
PRDD OUT Planned Sete itipie Hems) ¥ Set o future date or bianks

Besporse Calegory ple feoma I Uatick the o Fault Fousd categories
iBfatus ple tomsk Exclude
BOR Claszification 3 ¥iset to blanks

iBIF Planned Cate

‘3’ Exciude Targeted At
S Exciude bianks
¥ Set o bisnks

PTF Manned Date
iBiE Ticked U
Arctioned Team

ad de biapks
¥ Setto blanks

{
{
{
{
iTarget Releass Tyve i
{
{
§

E Double ciick the nuwmber shown to expose the result set (usuatly nothing]
Count of Summary

I
e Pay special attention to the “PROD OUT Planned Date” which may have had new future
dates added that need to be ticked
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Call Type
PROD OUT Planned Date

Fespor 5

Ny,
R
-

Status
HDR C¥
Farget
BiF Pla
PTE Bla
BIF T
Action

County

B Salect Ruttiphe e

3N M MM LA M

o

Tancet

£ 1

e If there are any CBIF Peaks to consider, a number will appear under the Count of

Summary

Count of Summary

"

o Double click on the number to open a new sheet with the relevant Peak(s) listed
o Go to “Collating the results” below

o Manually filtering way

e Go to the ##liveAffectingDefect tab

e Call Type [column F] is "# - Defect Identified"

S

N S s

(a fix is needed)

##| ivesffectingDefect

e Set the filter on Response Category [column J] to exclude the No Fault Found values

(see Appendix A)

e Set a filter on HDR Classification [column BF] to blanks

e BIF Planned Date [column U] must not be blank (it has to have been to a BIF meeting)
e Target Release Type [column S] is not Targeted At (as this means it has gone through

PTF already)

e PTF Planed Date [column AA] must be blank (it has not been to PTF)

e Planned Out Live [column AH] date is in the future or blank (it has not been deployed)

e The Actioned Team [column AJ] must be blank (i.e. not BIF (nhot ready for CBIF) or PTF
(gone past the CBIF step))

e BIF_Ticked_Questions [column AM] is not blank (BIF selected it for CBIF)

e Go to “Collating the results” below

o Collating the results:

e Check that each Peak(s) in the result set is/are correctly marked by reviewing the Peak
Details and looking at the Release Management (Release MGT) tab for notes that clarify.
Any Peaks that are confirmed as CBIF candidates then need a CBIF Proposal creating
as this is what will be submitted to POL.

e CBIF is part of the HDR meeting and any proposals should be submitted along with the
weekly HDR report for discussion at the weekly HDR meeting with POL.
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A.2 Appendix A — No Fault Found Response Category values

Peaks with the following Response Categories are deemed to be No Fault Found as no action was
required to remedy the issue raised. In some cases this is because the fault is within an area of the
system that is managed using TfSNow and hence Peak is not the source of the Live Defect information.

Response Category — 68 -- Final -- Administrative Response

Response Category — 95 -- Final -- Advice after Investigation

Response Category — 94 -- Final -- Advice and guidance given

Response Category — 70 -- Final -- Avoidance Action Supplied

Response Category — 200 -- Final -- Call withdrawn by user

Response Category — 120 -- Final -- Cloned to create Defect Peak

Response Category — 72 -- Final -- Duplicate Call

Response Category — 58 -- Final -- Documentation Fix Available to Call Logger

Response Category — 66 -- Final -- Enhancement Request

Response Category — 96 -- Final -- Insufficient evidence

Response Category — 62 -- Final — No fault in product

Response Category — 63 -- Final -- Programme Approved — No Fix Required

Response Category — 64 -- Final — Published Known Error

Response Category — 100 -- Final -- Route call to TfS

Response Category — 97 -- Final -- Unspecified insufficient evidence

Response Category — 98 -- Final -- User error

2.3 Updating the PIVOT Tab of the Weekly Defect Update
Report

The Pivot tab of the Weekly Defect Update report provides a table and graph that illustrates 1)
The Proposed For 2) Targeted At 3) TBC for the Defects displayed in the HDR Report — Open
Defects by Target Release and HDR collection i.e. Impact and Experience.

If no new defects are added to the report, then the table and graph can be refreshed to pick up
any changes by following the below steps:

e On the Pivot tab, select a cell within the table and then right click, to bring up the menu
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e [f new defects have been added to the HDR Report — Open Defects, then select the
PivotTable Analysis menu bar
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e The Change PivotTable Data Source menu will be displayed
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e Change the Table/Range to cover all the active rows and then click ok

e  This will then return you to the Pivot Tab
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e Again it is worth refreshing the table.
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2.4 Providing updates to POL Questions in the meeting and
additional questions

As a result of the weekly HDR meeting there maybe questions raised by POL that you will need
to read the Defect PEAK or engage the required technical resource to gain the required updates
to add to the Impact Tab so a revised HDR Extract can be provided in the next HDR Report.

Additionally, POL may send questions on HDR Defect PEAKS in order to gain clarification, that
will again need to be added to the Impact Tab so a revised HDR Extract can be added to the
HDR Report.

These actions can be performed outside of the producing of the weekly HDR Update Report in
order to be ready to add the report against the appropriate HDR Defect PEAK in the report.

2.5 Sending POL the Weekly HDR Report

e Once all the required changes have been added to the HDR Report, you are now in a position to
create v1.0 to send to POL by approximately 10:00 on a Friday morning, in preparation for the
HDR meeting with POL on a Monday morning (Usually 11:45). If you send it a little late owing to
awaiting an update from a technical resource, that is not a big issue as long as it is sent to POL
by close of play on the Friday.

o Open the latest draft version of the report i.e. HDR Defects Update Report v0.2

o Ensure that all the required updates, HDR Extracts and Screenshots have been added to
the report. This includes checking against the actions from the minutes of the previous
meeting sent by POL in order to ensure that the required information to answer POL
questions is included in the HDR Extracts for the appropriate HDR Defect PEAKS. This
will assist in confirming the status of the Fujitsu actions from the previous meeting.

o If so, remove the word “WIP” into cell B2 and save the report as "HDR Defects update
report — dd.mm.ccyy v1.0.xlsx”

o Next prepare the email to be sent to POL that the report needs to be attached to. Please
see example of the weekly email for the HDR Update Report below:

From: Hatch, Matthew
Sent: Friday, March 17, 2023 9:53 AM

To: Michelle Stevens i__, GRO i Lisa.millard GRO i
Cc: POA DutyManager + GRO ! Bansal, Steve
(BRAO1)i K., 7, Bothick, Sandie 4 GRO 3
Browell, Steven! GRO i : g

Subject: HDR Defects Update Report - 17.03.2023 - v1.0

Good Morning Michelle,

There are NO CBIF candidates to put forward this week and NO NEW DEFECTS to
raise.

There is also NINE updates to the existing entries, that have been highlighted in yellow in
the update column.

Changes to report and updates:

e The pivot has been updated
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e The NINE updates are:
o 1 has had the Target Release Type on the report updated to reflect the
Defect. (Cosmetic change)
o 6 are awaiting an update from POL following a review being performed
and a decision being made.
o 2 awaiting an update on POL Reference Data from lan Humpbhries.

There are NO OPEN ACTIONS for Fujitsu from the previous HDR meeting (13.03),

Owing to the above, | am happy to approve the minutes from a Fujitsu perspective for the
HDR meeting held on the 13.03.2023.

Thanks for your support.

o Then add the report version 1.0 “HDR Defects update report — dd.mm.ccyy v1.0.xIsx” to the
email and send to

2.6 Saving the reports, minutes and emails to SharePoint

In order to have an audit record of the HDR Defect Update reports, emails sent to POL and emails and
minutes of the meetings sent by POL to Fujitsu, there is a SharePoint location whereby all of these
emails and documents are held. Following the sending of the weekly report to POL, or responding to POL
emails with questions or the receiving of meeting minutes from POL please save them to the below
SharePoint location:

Service Management - Horizon Defects Review (HDR) - started June 2021 - All Documents
(sharepoint.com)

2.7 LIVE Defect Management Monthly Report Creation

To create the monthly Live Defect Management for POA stack owners and leadership, follow these steps:

o Create the Peak extract to build the report from
e Then, open any version of the “Peak_Defect_Management extract dd.mm.ccyy
hh.mm.xlIsx” spreadsheet and Enable Content and go to the Data tab and click Refresh
All on each tab. The password to run the embedded queries needs entering 3 times and

is EIRRELEVANTE Save the resulting file with the timestamp to match when the extract was
created — so it can be referred back to. Turn off AutoSave
o Prepare the report
e A spreadsheet format has been used to date so the previous month’s
“POA_Live_Defect_Management Monthly Report dd.mm.ccyy hh.mm.xlsx” should be
used as the basis for the new report. To show history, copy the white box on the top left
of the Summary tab and paste it to the right as an image (you may need to delete a
previous image)
e Save the file with the same date and time values as the Peak extract created earlier so
you know which extract the report relates to
o Go to the #HiLiveAffectingDefect tab and filter as follows

Then the 5 tabs are derived as follows:

Check the range of values in the Call Type column. If there are any that are neither “Live Incident”
nor “Defect Identified” then these need to be looked at to decide whether to treat them as one of
these 2 categories. There shouldn’t be any, but if there are, it is most likely to be Vulnerability which
can be treated as Defect Identified. If so, amend the filtering below where ** is shown.
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o Still Investigating
e Clear all filters
e Filter the Planned Out Live date so it is in the future or blank (it has not been deployed)
e Filter out the No Fault Found Response Category values (see Appendix F)
e Filter Call Type to “Live Incident” ONLY **
= Consider filter on Status to exclude “C’losed — but beware the closures may be
wrong
e Extract the columns shown on the tab from the filtered list and paste the values into the
report
e Expand/contract the Stack owner column by copying/pasting the formula so all rows are
attributed to a name
o DI~ Solutioning
e Clear all filters
e Filter the Planned Out Live date so it is in the future or blank (it has not been deployed)
e Filter out the No Fault Found Response Category values (see Appendix F)
e Filter Call Type to “Defect Identified” ONLY **
e Filter “Target Release Type" to exclude “Targeted At” and “Proposed For”
= Consider filter on Status to exclude “C’losed — but beware the closures may be
wrong
= Manually add back in any that are “Targeted At” or “Proposed For” and Target
Release is “Re-target” if there are any
e Extract the columns shown on the tab from the filtered list and paste the values into the
report.

2.8 Creating the POL All Live Defects Report

Fujitsu have agreed to create a report called “POL All Live Defects Report” on a fortnightly basis and
send to POL.

In order to create the report please following the below instructions:

1. Run the "Peak_Defect_Management extract dd.mm.ccyy hh.mm.xIsx" update and rename the file
accordingly
a. Update the filters on all tabs and Refresh the content
b. Save the file
c. Turn off autosave

2. Inorder to ensure that the new Response Category “Accepted Live Defect” is picked up and
reported against please follow the below instructions.
i In any Pivot tables you should now tick the Response Category “Accepted Live Defect”
so the entries are included. E.g.
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ii.  When you update the Pivot tables you will see a “5 — Accepted Defect” entry. |
recommend you collapse section 5 as follows:

HMNG-X 73.10 E
5 - Accepted Defect 4

_ Grand Total 26

3. Create the "HNG-X - All Live Defects Report for POL - dd.mm.ccyy.xlsx" file by copying the
previous version (the POL report)

i Update the Front Page to put the correct dates at the top
4. Go back to "Peak_Defect_Management extract dd.mm.ccyy hh.mm.xlsx"
a. Go to the Defect Stage Pivot tab and click on the number to the right of Grand Total
b. This will create a new sheet with all the Peaks on that you need
c. The columns then need reordering ready for placing into the POL report
d. Inorder...
i Cut column BI (Defect Status) and paste it prior to column A
1. Wrap Text will probably switch on so select all content and put Wrap
Text back off
ii. Cut column BF (HDR Classification) and paste it prior to column E
iii. Cut column BH (Deferred) and paste it prior to column F
iv. Cut column T (Workaround) and paste it prior to column G
V. Cut column S (POL SNOW Reference) and paste it prior to column H

Vi. Cut column BI (POL Problem Reference) and paste it prior to column |
Vii. Cut column X (Target Release) and paste it prior to column J
viii. Cut column BJ (Release Title) and paste it prior to column K

iX. Cut column BF (PROD OUT Planned Date) and paste it prior to column L
X. Cut column BN (Impact: Description) and paste it prior to column M
Xi. Cut column BU (Impact: Root Cause) and paste it prior to column N
Xii. Cut column BX (Impact: Fix Required) ( and paste it prior to column O
e. Sort column A A-Z (1 - Investigating will be at the top)

f. For all top rows where Defect Status is 1- or 2- blank out columns J, K, and L

i.  For any rows at the bottom where Defect Status is 5- For any rows at the
bottom where Defect Status is 5- blank out columns J, K, and L
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g. Filter column BN (Impact:Date of Issue) to dates AFTER the last report AND including
Blanks - to show only those that have changed since the last report was run
i Filter column E (HDR Classification) to blanks only - the HDR ones will have
been scrutinised already
ii. Check columns M, N and O read well and request amendments if not - apply
manual edits to this extract to save repeating above steps
h. Remove filter column E (HDR Classification) and filter column AW (HDR_Date) to show

those declared HDR since the last report

i Check columns M, N and O read well and request amendments if not - apply
manual edits to this extract to save repeating above steps

i. Clear the filter to show all rows (Menu - Data - Clear for speed)

j.  Select from row 2 until the end and take columns A-O

k. Copy the text

5. Go back to "HNG-X - All Live Defects Report for POL - dd.mm.ccyy.xlsx"
Place cursor on cell A2 and Paste values
Check that there are no extra rows from the previous report - delete if there are
Unhide the tab "By Release" and Refresh it
Select all contents except the header row and then paste alongside as an image
Crop the image to remove the Pivot table "-" symbols
Cut the image and paste it on the Front Page - resize and position correctly
Hide the "By Release" tab
Save the spreadshest
Select the entire "All Live Defects" sheet (top left corner left of A and above 1
Double click a row marker to cause resizing to fit contents
Amend the screen so you can see columns M, N and O
Slowly scroll down the file adjusting any cell heights where content looks to end oddly to
ensure all content is visible
. File Print and select "Print Entire Workbook"

Set printer to "Microsoft Print to PDF"
Check Preview of all pages
Press Print
Then the below pop up “Microsoft Information Protection” will be displayed

TAT T SQ@ S0 o0 T

LT O35 3

rosoft information Protechion

Files yiou creste from the Print command may lose their
sensitivity labels and other content metadata, such as
arcessibilby tags.

Continue to File » Export to create files that preserve
beour crganization’s policies recemmended]

an

% Print without sensitivity labels and other metadata,

L e
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Microsoft Information Protection

Files you create from the Print command may lose their

sensithvity labels and other content metadats, such as

accessilulty tags,

L. Continue to File > Fxport to create files that presenve
wour organization’s policies {recommendsad).

@ [Print without sensitivity labels and other metadata.]

Ly mors

cior. Go

Hon Tor rep
sabbon iy iy

o mu
el

S.
to the report to customer and the internal DL

wicrosoft information Protection

Files you create from the Print command may lose their

sensitivity labels and other content metadats, such as

accessibilty tags.

L Continue to File » Bxport to create files that presens
your organization’s policies frecommended),

*® IPrint without sensitivity labels and other metadata. |

Learn miore

Al Data i reguired fo be provided in the report to the
ustomer and the internal DL

Next you will be required to select “Print without sensitivity labels and other metadata

Please add a comment that provides justification i.e., All Data is required to be provided

t. The Print Button will then be enabled as above. Click on the Print Button

u.

Save file as "HNG-X - All Live Defects Report for POL - dd.mm.ccyy.pdf™

6. Go back to "Peak_Defect_Management extract dd.mm.ccyy hh.mm.xlsx" and delete the sheet

you manipulated to create the view for POL

a. Save the file
b. Close the file

© Copyright Fujitsu 2022-2024 .
pyright Fuj FUJITSU RESTRICTED Ref: SVM/SDM/PRO/4695
Version: 3.0
UNCONTROLLED WHEN PRINTED OR Date: 26-April-2024
STORED OUTSIDE DIMENSIONS Page No: 27 of 28



FUJ00234993
FUJ00234993

: POST OFFICE ACCOUNT DEFECT MANAGEMENT REPORTING
FU}ETSU FUJITSU RESTRICTED

e On the day of issue, send to Rohit Gogna E GRO and Michelle Stevens
i GRO tin POL

s

HNG-X - All Live
Defects Report for PC

® Forward a copy of the Sent Item to POA recipients: Hatch, Matthew

P GRO > Bansal, Steve (BRAO1) < GRO i Duhaney,
Joan GRO +; Bacon, Rosie: GRO Allen, Graham
(BRAOTYS GRO. i Walton, Daniel 4 GRO i Evans,
Steve (BRAOT)¢ GRO i Browell, steVei i Gro

o

FW_HNG-X - All Live
Defects Report for PC

2.9 Saving the emails for the All Live Defects Reports for
POL to SharePoint

In order to have an audit record of the HNG-X All Live Defects Report for POL reports, emails sent to
POL, there is a SharePoint location whereby all of these emails and reports are held. Following the
sending of the HNG-X All Live Defects Report for POL, or responding to POL emails asking questions
about the report, please save them to the below SharePoint location:

All Live Defects Report - POL
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